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Getting Started

Access to Sorting

Your user profile level controls what you can do in terms of sorting levels, attribute relationships, measure items,

and totals in views.

User Profile Level Apply New Sorts Edit Existing Sorts
Casual ® e
Advanced 4 Y 4
View Administrator W "
Security Administrator " "

*Note: Casual users can click an existing sort icon to change a sort. They will not see a Sort option when they right-
click in the grid to access the grid pop-up menu.

Introduction to Sorting

Sorts are a means of sequencing your data in a way that is most meaningful to you. Descending and ascending
sorts can be applied to a level, an attribute relationship for a level, a measure item, or totals. You can combine sorts
with filters to achieve a view of data that best fits your particular business needs.

Numeric Sorts

Stratum.Viewer will sort measure data numerically. Attribute relationships defined as a number will also be sorted
numerically. The following view has an ascending sort on the first measure item.

E:Z+ View Hame: Sales by Type and Territory
4|+ View Filter
{ & Actual sales "Actu?l Sal_es Ext Difference Actu?l Sal_es Ext Actu?l Sal_es E
Customer Ship-To Territory Ext List Price List Price Current Wk List Price List Price
Type Wk382014to | Wk382013t0 WETE K wk372014t0 Wk 372013t
Wk 28 2014 Wk 38 2013 Wk 37 2014 Wk 37 2013
Class A Customer Central Provinces 51,251,445 $1.407 532 -5156,087 51539277 51,407,573
Gulf Coast £1.356,559 £2,107,039 -5750,480 §1,668,568 §2,107.07
Morthwest $1.686,239 51,391,828 5284411 52,074,074 51,391 8]
Great Plains 84 544 327 84 838 341 -$204 014 55,589,522 84 838 34
Western Provinces 54,832,958 $5,513,788 -5680,830 55,544 338 $5,513.7%
Midlantic £5,103,240 §£5,629.220 -§525,280 86,277,847 §5,629.2]
Eastern Atlantic Provinc 56,627, 886 57,647 500 -51,019.614 58,152,259 57,647,540
South Central §£10,714,654 §12.376,633 -$1,661,979 §13,179,024 §12 376,67
Mew England 513,481,53 $15,779,759 -52,297 825 516,582,775 515,779.7]3

| GrandTotall |

| sseooren]| s7001703]  s61.00792]  ssesone
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The next view has a descending sort on the Prod Current List Price attribute relationship. It's a numeric sort
because the attribute relationship was set up to have its data treated as numbers in this view.

View Filter: +
More Info
Budget Budget Amount Frozen Actual Sales Sales Amount Budget Budget Units Frozen Actual Szles Sales Units
T Product ¥ T Prod Current List Price Jan 2020 to Sep 2020 Jan 2020 to Sep 2020 Jan 2020 to Sep 2020 Jan 2020 to Sep 2020
Applesauce 1060z PL* 4D 65 $231,221 §375,023 4,809 6,193
Blackberries 120z BR* 4D 53 £11,156 £18,922 285 384
Blueberries 120z BR* 4D 53 $6,458 £10,806 167 222
Applesauce 120z BR* 4D 47 £16,718 £28,274 489 656
Baby Carrots 4D 47 §1,053,108 §1,715,741 33,344 43,341
Apples Red Delicious 4D 46 §5,150,594 $8,546,319 167,167 220,334
Applesauce 120z PL* 4D 41 £69,023 §112,455 2,330 3,014
Bananas 4D 26 $323,200 $558,491 16,472 22,578
Grand Total $6,861,478 $11,366,032 225,064 296,722

Alphanumeric Sorts

Stratum.Viewer will sort most non-calendar based objects alphanumerically. Attribute relationship designated as
text (default) will be sorted alphanumeric. The following view has a descending sort on the Region level in columns
and ascending sort on the UPC Long Description attribute relationship in rows. The sort on the attribute relationship
is treated alphanumerically in this example because it was set up to have its data treated as text in this view.

EZZ+ View Name: Total Number Products Sold
4| View Filter
¥ T Region>> 331 330 Al C
Rgn Long Description West East
{ \ Sales Amounk Sales Return Number  Total T Sales Sales Return  Number  Total
UPC Global A UPCLong Q3 2014 to Amount of Mumber Amount Amount aof Number Q3
Number Description 03 2014 Q3 2014to  Products of Q3 2014 to Q3 Q3 2014to  Products of tol
03 2014 Sold  Products 2014 Q3 2014 Sold  Products
0 - 24000 - 12431 - 4 |Applesauce 1060z PL* 512,208,965  (5234,621) 50 103 $43.709.710 {5394,621) o4 103
0 - 24000 - 12531 - 4 | Applesauce 120z PL* 50 103 £30,325 482 (8213,278) G4 103
0 - 02749 - 25408 - & | Asparagus $11, 748,521 (§372.,975) 50 103 $32.856,000 (51,057.052) e4 103
0 - 02749 - 99267 - 6 | Cherries, Bing §14.001,060 ($528.751) 50 103 $32.473,135 ($1,.202,761) 94 103
0 - 13800 - 30321 - 9 |Frozen Lasagna Dinner 516,962 271 50 103 $50.440,138 o4 103
0 - 13800 - 78934 - 9 |Meatloaf, Frozen §15,994 439 50 103 $57.645,091 G4 103
0 - 06403 - 92736 - 2 | Orange Juice Conc. $9,566.166 50 103 $31.563.473 o4 103
0 - 24000 - 12520 - 4 |Peach 6oz LnchPk BR* 50 103 $20.887.455 ($252,701) o4 103
0 - 24000 - 12491 - 4 |Peach Slcs LS 1060z BR™ $2.32047%  (5108,534) 50 103 $28,007.355 (5304,192) a4 103
0 - 24000 - 12591 - 4 |Peach Slcs LS 120z BR* 50 103 £38,969,187 (8176,420) G4 103
0 - 24000 - 12578 - 4 |Pear 6oz LnchPk LS 50 103 $15,837 466 (5171,811) e4 103
0 - 24000 - 12517 - 4 |Pnappl Slcs 12 oz BR* 50 105 $27,126524  ($318,541) 94 103
0 - 70606 - 02232 - § |Pork Chops - Butterfly 38,406,051 50 103 $34,580,280 o4 103
0 - 79453 - 59433 - 6 |Romaine Spedalty Salad §5,762,298 30 103 $26.027.675 o4 103
0 - 79453 - 09722 - 7 |Sweet Onions, Chopped $6,963,593 50 103 $26.900,805 o4 103
Al Others §118.055,909 (55,168,630) 50 103 5700171922 ($12.648.224) o4 103
Grand Total $222,081,751 | ($6.434.517) 50 103 $1.225.521,698 | ($16.739.600) 94 103
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Calendar Based Sorts

Stratum.Viewer will sort calendar based objects according to their calendar order. Calendar based objects are
objects related to time, such as a Year or Months time level and their attribute relationships. In this view,
descending sorts exist on the Year Based level in columns and Months level in rows.

EIZ+ View Name: Monthly Sales Views
4|~ view Filter Company

Last Year )

G T YearBased == CurrentYear

$350,714,364

£,258,847 $56.03

$630,655,727

/’- ¥ Months \ ﬂiﬂﬁt Sales Units Awg Seling Price mﬂﬁt Sales Units  Awg Selling Price
December §220,048.674 3624739 $60.71
November $367 487,985 6,093 229 §60.31
October $304 333,571 6,581,500 §58.01
September $569,861,272 12,093,515 $47.12  $627,060,751 11,125,528 $56.36
August 485 764,510 12,744274 §38.12  §755,75497% 13414447 §56.34
July $391,977,666 9,613,083 $40.78  $997.610.460 17,833,690 $55.63
June §375671,285 8,810,154 §42.16 5682857762 12242875 §55.78
May $352,020,685 7,798,802 $45.14 5468934747 5,413,481 §55.74
April §327,807.806 6867712 §4773 5645861506 11733747 §55.04
March $361,004,874 6,553,215 $55.09 $652,242,257 11,862,018 $54.59
February §322,332,391 5,825,361 §55.33  $549211.665 9929320 §55.31

11,579,068 $36.19

anua
m

Apply a New Sort

1. Right-click the object in the grid and select Sort then either Ascending or Descending. If you want to sort a
Grand Total, right-click the caption of the measure item in the Grand Total row or column.

OR
1. Double-click the object in view explorer to open its Properties window.

2. Select Ascending or Descending from the Sort drop-down list.

Note: Use the first option if you are sorting a measure item and there are levels on the same axis as measure
items. Also use the first option if you are sorting a Grand Total measure item.

Edit Existing Sorts

1. Click the sort icon (& or¥) next to the sorted object.

OR

1. Double-click the object in view explorer to open its Properties window.
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2. Change to Ascending or Descending using the Sort drop-down list.

Clear Sorts

Clear Individual Sort

Right-click the sorted object in the grid and select Sort then Clear.

OR

Double-click the object in view explorer to open its Properties window. Then select None from the Sort drop-down
list.

Clear All Sorts

Right-click any sorted object in the grid (measure item, level value, level attribute relationship), and select Sort then
Clear All.

Grid Pop-up Menus

Right-click objects in views to display available functionality for them such as inserting measure items, transposing
the grid, filtering objects in the grid, and so forth. Many of the functions can also be controlled through view explorer
and the Properties window, giving you several ways to make changes. Options on pop-up menus vary by user.
Your user profile level determines which options are available to you. The menus in these examples are for a user
with an advanced level of access. Menus are displayed in alphabetical order.

Attribute Relationships Pop-up Menu

Right-click an attribute relationship to display actions that you can take related to that object or axis.

o More Info
Select All
e Add b
Edit >
Hide o
e Sort »
Filter >
6 Actions r
Transpose
View Explorer e
Properties

o More Info — Opens more details about the attribute relationship in the Stratum Glossary.
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Copy - This option allows you to copy sections of a view that you have selected.

Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views.

Select All - Use this option to select the entire grid.

Add - The sub menu has options for adding Attribute Relationships, Regular Measure ltems,
Calculated Measure ltems, and Charts. Windows for adding the selected type of item will display once
you make your selection from this sub menu.

m Attribute Relationships

Regular Measure Item
Calculated Measure Ttem

Chart

Edit - Edit the attribute relationships or edit hierarchies on the rows, columns, or view filter.

m Attribute Relationships

Rows

Columns
View Filter

Hide - When an attribute relationship is right-clicked and Hide is selected, the selected object is
hidden from the grid. The Visible property for the attribute relationship changes to No. From view
explorer, you can drag an attribute relationship back in the grid if needed, or you can change the
Visible property to Yes.

Sort - Sort options are Ascending, Descending, Remove, and Remove All.

Sort » Ascending
Descending
Remove

Remove All

Filter - Filter options are Edit, Clear, and Clear All.

cor

Clear

Clear Al I
e

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.

Actions » Add Action
Add View To Existing Action
Display Actions That Indude This View

Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in columns are switched to display in rows and vice versa.

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.
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Properties - Click to maintain the attribute relationship properties including sorting and whether it is
visible or not.

Axis Pop-up Menu

Right-click the Rows or Columns headings in the Navigation Panel (or their filter icon if an axis is filtered) to display
a menu with options to edit properties of that axis including its filter, totals, or All Others properties. A shortcut to

adding hierarchies to the Rows or Columns of a view is to click the Add icon - in those sections of the Navigation
Panel.

Edit

Filter L Edit
Clear

Totals »

all Others r Clear All

Properties

General Pop-up Menu

Right-click within the grid to display actions that you can take such as transposing the rows, columns, and measure
items.

Copy
Select all

Add 4
Edit 4

Actions ]

Transpose

View Explorer

Copy - This option allows you to copy sections of a view that you have selected.

Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views.

Select All - Use this option to select the entire grid.

Add - The sub menu has options for adding Regular Measure ltems, Calculated Measure Items, and
Charts. Windows for adding the selected type of item will display once you make your selection from
this sub menu.

© 060060

IR Regular Measure Item

Calculated Measure Item

Chart

Edit - Edit the hierarchies on the rows, columns, or view filter.

BT cos

Columns

View Filter
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Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.

Actions b Add Action
Add View To Existing Action
Display Actions That Indude This Wiew

Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in rows are switched to display in columns and vice versa.

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.

Measure Item Pop-up Menus (Detail and Grand Total Menus)

Measure items can be assigned to one axis, either rows or columns. Right-click the caption of a measure item in a
detail row or column to display actions that you can take related to that object, such as inserting additional measure
items or applying conditional formats.

Mare Info

Copy
Select All Occurrences

Select all

Add ]
Edit
Delete

Hide 0

Sort
Filter »

Conditional Format »
Actions

@0 0 00

Transpose
View Explorer
Properties

Or, right-click the caption of a measure item in a Grand Total row or column to work with values in that area of a
view, such as by applying sorts and filters to them.

Descriptions follow of the menus for measure items in detail and Grand Total rows or columns.

o More Info — Opens more details about the measure item in the Stratum Glossary.
e Copy - This option allows you to copy sections of a view that you have selected.

Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views. This option does not display on the menu for Grand Totals.

Select All Occurrences - Use this option to select data for all occurrences of that measure item in
the active page of the View. This option does not display on the menu for Grand Totals.

Select All - Use this option to select the entire grid.
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Add - The sub menu has options for adding Regular Measure Items, Calculated Measure Items, and
Charts. Windows for adding the selected type of item will display once you make your selection from
this sub menu.

Reqular Measure Item
Calculated Measure Item

Chart

Edit - For regular measure items, opens the Edit Measure Item window with that measure item
selected for editing. You can edit that measure item or any other regular measure items. For
calculated measure items, opens an Edit window where you can edit the calculation, caption, and
format for the calculated measure item.

Note: You also can access editing windows for measure items from the Measure ltems window,
which is accessible from view toolbars, or by double-clicking the caption of the respective measure
item in the view grid.

Delete - Deletes the measure item from the view definition without confirmation. It will no longer
display in the view explorer.

Hide - When a measure item is right-clicked and Hide is selected, the selected object is hidden from
the grid. The Visible property for the measure item changes to No. From view explorer, you can drag
a measure item back in the grid if needed, or you can change the Visible property to Yes.

Sort - Sort options are Ascending, Descending, Clear, and Clear All.

|
T fscending

Descending
B Clear

Clear all

Filter - Filter options are Edit, Clear, and Clear All.

car

Clear

Clear Al I
e

Conditional Format — Use this option to edit or add conditional formatting on the measure item.
There are also options for clearing the conditional format on the active measure item or all measure

items.

| Condtional Format [
Actions 3 Clear
Transpose
Clear Al

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.

Add Action
Add View To Existing Action
Display Actions That Indude This View

Actions k
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Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in columns are switched to display in rows and vice versa.

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.

Properties - Click to maintain the measure item properties including the name, caption expression,
type, pop-up labels, hyperlinks, and so forth.

View Filter Pop-up Menu

Right-click the View Filter heading to display actions that you can take related to that object or section of the grid,
such as filtering levels in that section.

o Edit

Properties

Edit - Edit the hierarchies in the view filter. A shortcut to adding hierarchies to the View Filter is to
click the Add icon = that's provided in the View Filter section of the view.

Levels Pop-up Menu

Right-click the level to display actions that you can take related to the level, such as editing the hierarchy.

More Info — Opens more details about the level in the Stratum Glossary. If you right-click a level’s
member and choose More Info, you will see more details about that member such as its value and
attribute relationships for the level.

Copy - This option allows you to copy sections of a view that you have selected.

o More Info
Copy
Select All
Add »
Edit r
Hide o
Sort r
Filter r
Actions >
Transpose
View Explorer
Properties

Paste - Allows you to paste data into update enabled cells. This option only shows in planning
enabled views.

Select All - Use this option to select the entire grid.

10 Working with Sorts




Add - The sub menu has options for adding Attribute Relationships, Regular Measure ltems,
Calculated Measure Items, and Charts. Windows for adding the selected type of item will display once
you make your selection from this sub menu.

m Attribute Relationships

Regular Measure Item
Calculated Measure Ttem

Chart

Edit - Edit the attribute relationships or edit hierarchies on the rows, columns, or view filter.

m Attribute Relationships

Rows

Columns
View Filter

>

Hide - When a level is right-clicked and Hide is selected, the selected object is hidden from the grid.
The Visible property for the level changes to No. From view explorer, you can drag a level back in the
grid if needed, or you can change the Visible property to Yes.

Sort - Sort options are Ascending, Descending, Clear, and Clear All.

|
PRETTE ascending
Descending
Clear

Clear Al

Filter - Filter options are Edit, Change Filter Type, Clear, and Clear All. Change Filter Type opens a
window where you can select the type of filter to set up or change. By default, a new filter you create
from the Filter > Edit option is a list of members from the level with which you are working.

___Aer [T

Change Filter Type

Clear

Clear All

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.

Actions » Add Action
Add View To Existing Action
Display Actions That Indude This View

Transpose - Use this option to change the axis for levels and measure items in the grid. Objects
displayed in columns are switched to display in rows and vice versa.

View Explorer - This option allows you to open and close view explorer. If the Properties window is
open when you close view explorer, the Properties window will also close.

Properties - Click to maintain the level properties including the filter, sort, totaling, visibility, and
display text.
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View Name Pop-up Menu

Right-click the view name to display actions that you can take related to the overall grid, such as exporting to Excel.

o Delete

Actions >
Excel

Print

Share

e Properties

Delete - Choose Delete to delete the view with confirmation. Anyone can delete their own personal
views, but only view and security administrators may delete global views.

Actions — Use this option to add new actions, add the active view to existing actions, or display the
actions that include the active view.

1
Actions [ Add Action
Add View To Bxisting Action
Display Actions That Indude This View

Excel - Click to initiate an export of the view to Microsoft Excel.
Print - Click to print the active page of the view.

Share — Click to open a window with the URL for the view. Click Copy to copy the URL to use for
sharing with other Stratum users.

group.

9 Properties - Click to maintain the view properties including the name, description, type and view

Properties Window for Attribute Relationships

Properties - UPC Long Description x
MName: |UPC Leng Description o ‘
Caption Expression: |[Name] HZ‘
Data Type: Text hd
Filter:  Contains e |
Sort: | None hd
Visible:  es Ve
Fill Color: |

Name — The name of the attribute. Used in the view explorer and filter windows.

Caption Expression — A read only field that shows the expression behind the caption for an
attribute relationship. The resolved text generated by the expression creates the caption, which is
the text that displays for the attribute relationship in the view. The Caption Expression window can

be accessed for editing the expression by clicking the Browse button EI next to the field. Attribute
relationships will be referred to by their names in all other Stratum.Viewer locations that they appear,
such as in view explorer and the Select Members window.

12
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Data Type — Used to control whether the data for the attribute relationship is treated as Text or
Number values in the active view. If set to Text, the data will display left aligned in its column and be
treated as non-numeric data for filters and sorts. If set to Number, the data will display right aligned
in its column and be treated as numeric for filters and sorts.

Filter — Use to add, edit, or remove a filter on an attribute relationship. Select the operator from the
drop-down list and enter the value to filter by in the field next to the list. Pop-up labels showing filter
criteria will show for the Filter field after a filter has been applied.

Sort - Use to add, edit, or remove Ascending and Descending sorts.

Visible — Set this property to No to hide the attribute relationship in a view. Set this property to Yes
to display the attribute relationship in a view.

Fill Color — Assign a fill color that will be used in the row or column containing the attribute

00 © O

relationship. This makes it stand out from the rest of the grid. Click the Browse button EI next to the
Fill Color property to choose a color from the Color window. Or, if there is already a color selected
and you don’t want a fill color used anymore, select the No Color checkbox.

Properties Window for Individual Measure Items

Regular Measure Items

Properties - Actual Sales Sales Amount Wk 38 2020 to Wk 38 2020 x

Mame: |Datal ‘

7

Caption Expression: |[Measure] [From Period Short Desc] [From Year YYYY] | E

Type: Regular

w
Measure: |Actua| Sales Sales Amount | E
w

Format String: | As Is

Fill Color: | | E
~

Show Value: | Yes

I

Display Value As: | Sum ~

!

Show Image: MNo

~
Conditional Format:  Yes w ‘Sales less than 100K ‘E

Pop-up Expression: | Yes % |"Red indicator represents when sales are belov\‘ E

!

Hyperlink: | No ‘ ‘

e— visible: | Yes o
Filter: | Recursive Top Count W |15 ‘

o Sort: | Descendin ~

Total: | Total ~

9— Drilldown View: | No w |E

Name — The text in this field determines the unique name that Stratum.Viewer will use to identify a
measure item in the view. You can edit this field as needed. Default names given to new measure
items are DataN. The “N” is a sequential number assigned by Stratum.Viewer to create a unique
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name. You will be prompted to make corrections to the name if you enter a duplicate name, use any
spaces in the name, use too many characters (more than 50), or use invalid characters.

Caption Expression - A read only field that shows the expression behind the caption for a measure
item. The resolved text generated by the expression creates the caption, which is the text that
displays for the measure item in the view and other areas of the application such as view explorer.
The Caption Expression window can be accessed for editing the expression by clicking the Browse
button next to the field.

Type — This property shows the type of measure item you are working with — either regular,
calculated, or distinct calculated. The property will be set to “Regular” if you are inserting or editing a
regular measure item.

Note: See the next table for information about calculated and distinct calculated types.

Measure — This field is a read only field that displays the underlying measure you selected when
setting up the regular measure item.

e For measure items with time ranges, clicking the Browse Button U next to the Measure
field opens the Edit Measure Item window. Use that window to edit the measure item's
underlying measure or time range. The main Time Range property for a view must be set to
Yes for the Properties window to behave in this manner.

e For measure items without time ranges, clicking the search button Q next to the Measure
field opens the Select Measure window for editing the underlying measure. The main Time
Range property for a view must be set to No for the Properties window to behave in this
manner.

Format String — Use this drop-down list to apply a format such as decimal places, monetary
symbols, commas, or a combination of formatting.

Fill Color — Assign a fill color that will be used in the column or row containing the measure item.

This makes it stand out from the rest of the grid. Click the Browse button CJ next to the Fill Color
property to choose a color from the Color window. Or, if there is already a color selected and you
don’t want a fill color used anymore, select the No Color checkbox.

Show Value — Determines if the measure item value displays in the Viewer grid. Set to Yes to
display value. Set to No to hide the value, for example, in cases where you want to display only the
conditional format icon for a measure item.

Display Value As — This drop-down list only displays for measure items with time ranges. This
property defaults to Sum, and its other options can be used to create Key Performance Indicators
(KPIs) based on the selected measure.

e Sum - The sum of the values for the measure item within the specified time range. This is
the default and most commonly used setting for this property.

Min - The minimum value for the measure item within the specified time range.

Max - The maximum value for the measure item within the specified time range.

Avg - The average value for the measure item within the specified time range.

Med - The median value for the measure item within the specified time range.

StdDev - The Standard deviation of the measure item values within the specified time range.
The standard deviation is the average amount of variability in your dataset. It tells you, on
average, how far each value lies from the mean.

e Variance - The measure of dispersion of data points from the mean for measure item values
within the specified time range. Low variance indicates that data points are generally similar
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and do not vary widely from the mean. High variance indicates that data values have greater
variability and are more widely dispersed from the mean.

Show Image — This property is used when setting up calculated measure items that display images.
See the next table for information about this property.

Conditional Format — Controls the display of icons, and cell and text formatting for the measure

item by applying the conditional format rules. The Browse button [:J is only enabled when the
Conditional Format field is set to Yes. When enabled, you can click the button to access the Select
Conditional Format window to edit the conditional format associated with the measure item or create

a new one. The name of the selected conditional format displays in the text box left of the [:J icon.

Pop-up Expression — Use this property to specify whether the selected measure item has a pop-up
label that will display when you hover over the measure item value, indicator, or image. The Browse

button [:J is only enabled when the Pop-up Expression field is set to Yes. When enabled, you can
click the button to access the Pop-up Label Expression window to edit the existing expression or

create a new one. The active pop-up expression displays in the text box left of the [:J icon.
Hyperlink — Choose Yes if you want a hyperlink defined for the cell of a measure item. The Browse

button [:J is only enabled when the Hyperlink field is set to Yes. When enabled, you can click the
button to access the Hyperlink Expression window to edit the expression or create a new one. The

hyperlink defined displays in the text box left of the [:J icon.

Visible — Set this property to No to hide the measure item in the view. Set this property to Yes to
display the measure item in the view.

~J{o

Filter and Sort — Use to add, edit, or remove filters and sorts. For filters, select the operator from the
drop-down list and enter the value to filter by in the field next to the list. Pop-up labels showing filter
criteria will show for the Filter field after a filter has been applied.

If your view has levels on the same axis as measure items, these properties will be disabled until you
have applied an initial filter or sort via the grid.

Total — Use to control the type of total that is performed for a measure item. The default setting for all
measure items is Total.

o None — No total will be displayed.

e Total — This designation takes into account any underlying calculations for a measure item’s
definition when generating Grand Totals, sub-totals, and All Others — such as calculations
defined in a measure item expression or associated with a Stratum.Planner calculated value.

e Sum - This designation means that Viewer will generate totals by adding the values
displayed in measure item detail cells. That summing will be used to generate the Grand
Totals, sub-totals, and All Others. This type of total is intended for special cases where you
don’t want any of the underlying calculations that Viewer performs to be used when
generating total values. You might choose to use a Sum total when a measure item
calculation includes an IIF statement, such as a calculation with IF, Then, Else conditions.

9

Drilldown View - Assign a drilldown view if you want to drill from this measure item to another view,
for example, to a view with related or complimentary data to the originating view. Choose from views
that you normally have access to in the application. If you select a Drilldown view for both the
measure items axis and an individual measure item, the selection for the individual measure item
takes precedence.
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Calculated and Distinct Calculated Measure Items

Properties - Percent of Total Growth

0\ e
Caption Expression

7‘

Expression

Nﬂat String:
Fill Color:
Show Value:

0 Show Image:

Conditional Format:

16

Type:

Pop-up Expression:
Hyperlink:

Visible:

o Filter:
Sort:
Total:

9— Include In Relationship Filter:

Drilldown View:

X

: ‘Data?

: ‘Percent of Total Growth

Calculated

(-]

: ‘[Measures].[DataS (% of Total)] - [Measures]‘ E

#, F#2.000%
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L]

Yes W ‘#Measu reltem("Value")

=

o v | |

Yes w
w
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Mone v

Mo w

o v | ]

©

button next to the field.

Name — The text in this field determines the unique name that Stratum.Viewer will use to identify a
measure item in the view. You can edit this field as needed. Default names given to new measure
items are DataN. The “N” is a sequential number assigned by Stratum.Viewer to create a unique
name. You will be prompted to make corrections to the name if you enter a duplicate name, use any
spaces in the name, use too many characters (more than 50), or use invalid characters.

Caption Expression — A read only field that shows the expression behind the caption for a measure
item. The resolved text generated by the expression creates the caption, which is the text that
displays for the measure item in the view and other areas of the application such as view explorer.
The Caption Expression window can be accessed for editing the expression by clicking the Browse

Type — This property shows the type of measure item you are working with — either regular,
calculated, or distinct calculated. The property will be set to “Calculated” or “Distinct Calculated” if
you are inserting or editing that type of measure item.

Note: See the previous table for information about regular types.

Expression — When "Calculated" or "Distinct Calculated" is the measure item type, an Expression
field shows in this window. It's a read only field that shows the expression for calculating the measure
item. The Expression window can be accessed for editing the expression by clicking the Browse

button E] next to the field.
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Note that when you are using a calculated measure item to display images in a view that the
expression will determine the location/name of the image file for Stratum.Viewer to display.

e The image file must reside in the Stratum.Viewer application folders. It is recommended that
all custom images reside in a subfolder of the Images folder of the Stratum.Viewer
application.

e Supported file types for images are *.jpg, *.jpeg, *.png, *.bmp, *.gif, *.tif, and * tiff.

e The image will display according to its original, default size.

Format String — Use this drop-down list to apply a format such as decimal places, monetary
symbols, commas, or a combination of formatting.

Fill Color — Assign a fill color that will be used in the column or row containing the measure item.

This makes it stand out from the rest of the grid. Click the Browse button [:J next to the Fill Color
property to choose a color from the Color window. Or, if there is already a color selected and you
don’t want a fill color used anymore, select the No Color checkbox.

Show Value — Determines if the measure item value displays in the Viewer grid. Set to Yes to
display value. Set to No to hide the value, for example, in cases where you want to display only the
conditional format icon for a measure item.

Show Image — This property is used when setting up calculated measure items that display images.
You use the Expression window to define the location of the image and then set this property to Yes
in order for the defined image to display in the grid. See item 2 above.

Conditional Format — Controls the display of icons, and cell and text formatting for the measure

item by applying the conditional format rules. The Browse button [:J is only enabled when the
Conditional Format field is set to Yes. When enabled, you can click the button to access the Select
Conditional Format window to edit the conditional format associated with the measure item or create

a new one. The name of the selected conditional format displays in the text box left of the [:J icon.

Pop-up Expression — Use this property to specify whether the selected measure item has a pop-up
label that will display when you hover over the measure item value, indicator, or image. The Browse

button [:J is only enabled when the Pop-up Expression field is set to Yes. When enabled, you can
click the button to access the Pop-up Label Expression window to edit the existing expression or

create a new one. The active pop-up expression displays in the text box left of the [:J icon.
Hyperlink — Choose Yes if you want a hyperlink defined for the cell of a measure item. The Browse

button [:J is only enabled when the Hyperlink field is set to Yes. When enabled, you can click the
button to access the Hyperlink Expression window to edit the expression or create a new one. The

hyperlink defined displays in the text box left of the [:J icon.

Visible — Set this property to No to hide the measure item in the view. Set this property to Yes to
display the measure item in the view.

Filter and Sort — Use to add, edit, or remove filters and sorts. For filters, select the operator from the
drop-down list and enter the value to filter by in the field next to the list. Pop-up labels showing filter
criteria will show for the Filter field after a filter has been applied.

If your view has levels on the same axis as measure items, these properties will be disabled until you
have applied an initial filter or sort via the grid.

8

Total — Use to control the type of total that is performed for a measure item. The default setting for all
measure items is Total.

e None — No total will be displayed.
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e Total — This designation takes into account any underlying calculations for a measure item’s
definition when generating Grand Totals, sub-totals, and All Others — such as calculations
defined in a measure item expression or associated with a Stratum.Planner calculated value.

e Sum - This designation means that Viewer will generate totals by adding the values
displayed in measure item detail cells. That summing will be used to generate the Grand
Totals, sub-totals, and All Others. This type of total is intended for special cases where you
don’t want any of the underlying calculations that Viewer performs to be used when
generating total values. You might choose to use a Sum total when a measure item
calculation includes an IIF statement, such as a calculation with IF, Then, Else conditions.

Include In Relationship Filter — Defaults to No and is recommended in most cases for optimizing

calculations, especially those use include attribute relationships in their expressions. That default
makes for the most efficient calculation performance and gives you a more focused result set. The
default makes sure the calculation is only carried out for members in the view that have data for the
applicable measure item used in the calculation.

for example, to a view with related or complimentary data to the originating view. Choose from views
that you normally have access to in the application. If you select a Drilldown view for both the
measure items axis and an individual measure item, the selection for the individual measure item
takes precedence.

@ Drilldown View - Assign a drilldown view if you want to drill from this measure item to another view,

Properties Window for Levels

Properties - UPC Global Number

Mame: |L.'F‘C Global Mumbear

Caption Expression: |L.|F‘C =

Filter Maode: | Include

Filter: | Membars
Sort: | None

Total: | Yes

All Others: | Yes

Visibla: | Yas
Display Text: | Value

Fill Calar

66"

o Name — Name of the level. Used in the view explorer and filter windows.

Caption Expression — A read only field that shows the expression behind the caption for a level.
The resolved text generated by the expression creates the caption, which is the text that displays for
the level in the view. The Caption Expression window can be accessed for editing the expression by

clicking the Browse button El next to the field. Levels will be referred to by their names in all other
Stratum.Viewer locations that they appear, such as in view explorer and the Select Members window.

e Filter and Sort - Use to add, edit, or remove filters and sorts.

o Filter Mode — This property controls how Viewer treats a member list, user list, expression,
or named set filter. The “Include” option means the applied filter returns only the members
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specified by your filter selections/criteria. “Exclude” means the applied filter returns all
members except the ones specified by your filter selections/criteria.

o Filter - click the Browse button EI to access the Select Filter Method window and either add
or change a filter. If a filter already exists, the filter type displays in this field and a pop-up
label shows filter criteria.

e Sort - use the list provided to add Ascending or Descending sorts or to change or remove a
sort.

Total — Use to control whether or not Total values display for the level. When the property is Yes,
totals will display for the level, When the property is No, totals will not display.

All Others — Use to control whether or not All Others values display for the level. All Others values
represent the sum of all members not in a filter. When the property is Yes, All Others values will
display for the level, When the property is No, All Others will not display.

Visible — Set this property to No to hide the level in a view. Set this property to Yes to display the
level in a view.

Display Text — This property controls what displays in the first row or column for the level. The
default is the level value. You can change it to any of the attribute relationships that have been made
available in the view for the level.

Fill Color — Assign a fill color that will be used in the row or column containing the level. This makes

it stand out from the rest of the grid. Click the Browse button EI next to the Fill Color property to
choose a color from the Color window. Or, if there is already a color selected and you don’t want a fill
color used anymore, select the No Color checkbox.
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Advanced Concepts

Calendar Based Sorting

Calendar based objects are objects related to time, which are time hierarchies and their levels. Examples of time
hierarchies and levels are Year Based Months Based, Rolling Year Based Months Based, Year Months, and
Months. Sorting on calendar based objects is based on their calendar order. By default, the objects are displayed in
order of oldest to most current. You can apply a descending sort to arrange objects from most current to oldest. To
return the order to the default sequence, either apply an ascending sort or remove the sort all together. Sorting acts
the same whether you sort the time member's value or attribute relationship.

A few examples follow.

e Absolute Time
e Based Time

View Explorer

4  Calendar Based Sorting
, Parameter Groups
4 | Grid
| Rows

4 | Columns

a4 17 Year Based Months Based
* ‘fear Based
= Maonths Based

a 17 Roling Year Based Months Based
* ‘Year Based
= Maonths Based

a 17 Year Months
* Year
= Months

4 17 Months
= Months

Viewy Filter
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Absolute Time
Example 1

The Year Months hierarchy is on columns and Months hierarchy is on rows in the following view. No sorting has
been applied yet.

EII+ View Name: Calendar Based Sorting
4|~ View Filter

Year > 2012 2013 2014

Mont} Actual Sales Actual Sales Actual Sales Actual 5ales Actual 5ales Actual 5ales

- Units Amount Units Amount Units Amount
January 5,007,078 $280.571.491 11579068  $650,655,727 6,258,847  $350,714,364

4660289  $257.865.913 9929320  $549.211669 5825361  $322,332,391
March 5,242,572  $288,803.899 11862018  $652,242,257 6553215  $361,004,374
Apri 4744533 $262,246245 11,733,747 5645861506 6867712  $327,807,306
May 4991233 $277,181642 8413481  $468934747 7,798,802  $352,020,685
June 5287949  $295804171 12242975  $682957,762  B910,194  $§375,671295
Juby

August

g
E

6008177  $334309311 17,933,690 5997610460 9613083  %301,977.666
7071967  $394294470 13414447  $755754978 12744274  $485,764,510

September 7,739,349  $435840359 11,125528  $627.060,751 12,093,515  $569,861272
October 6.152,790  $364922428 6581900  $394,333,371
Movember £917.943 8421277384 6093220  $367.487.985
December 3,740,752 $227.090225  3,624.759  $220,048,674

Grand Total|_67.575,132] $3.840207.508] 124534163] s7.012.160085] 76,665,003] $3.597,154864

A descending sort is applied to the Year level on columns, changing the order from 2014 to 2012. A descending
sort could be applied to Months on rows too, if needed, and that would change the order from December to
January. In this case, the order has been left at the default of January to December.

EXZ+ View Name: Cafendar Based Sorting
4|—+ View Filter

{ hd 2014 2013 2012 )
Year == — — —

Actual 5ales Actual Sales Actual 5ales Actual 5ales Actual 5ales Actual 5ales

Months Units Amount Units Amount Units Amount
Tarwsary 6,258,847  $350,714364 11,579,068  $650,655727 5,007,078  $280,571491
February 5825361  $322,332391 9929320  §$549.211,669 4660289  $257,865913
March 6553215  $361,004,874 11,862,018  §652242257 5242572  §288,803,899

April 6,867,712  $327,807.806 11,733,747  $645861,506 4744533  $262,246,245
May 7,798,802 $352,020685 8413481 468,934,747 4991233  §277,181642
June 8910194  $375671,295 12,242975  $682,957,762 5287949  $295804,171
July 5613,083  $351977.666 17933690  $997610460 6008177  $334,309311
August 12,744274  $485764510 13414447  §755754978 7071967  §394,294.470
September 12,093,515 $569,861,272 11,125,528  $627,060,751 7,739,845  §435.840359

October 6,581,900 £304 333 571 6,132,790 $364,922 428
November 6,005,229 §357,487,985 6,527,543 421,277,394
December 3,624 759 £220,048.674 3,740,752 £227.090,225

|Grand Total| _76,665,003] $3537,154864] 124,504,163 $7,012,160085] 67.675,1%2]
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Example 2

There are two levels from the Year Months hierarchy showing in this view. No sorting has been applied yet. The

Year level has been filtered to display the years 2012 through 2014.

EEZ+ View Name: Calendar Based Sorting
4|~ View Filter

T Year Months Actual Sales Units Actual Sales Amount
2012 January 5,007,078 $280,571.491
February 4 660, 289 5$257,865,913

March 5,242 572 5288.303 355

Apri 4,744 533 $262,246,245

May 4,991,233 §277.181,642

June 5,287,945 $295.804,171

Juby 6,008,177 $334.300311

August 7,071,967 $394.294 470

September 7,735 845 5435 840355

October 6,152,790 $364.922 428

Movember 6,927,843 421277304

December 3,740,752 $227,090,225

2012 Total 67,575,132 $3,840,207,548

2013 January 11,579,068 $650,655,727
February 9,926 320 5549 211 669

March 11,362,018 $652,242,257

Apri 11,733,747 $645 361 506

May 8,413 481 $468.934,747

Juna 17 247 Q75 RRTT O5T7 T87
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A descending sort on Months changes the order of months for each year from the most current of December back
to the oldest month of January.

¥ Months

EIZ+ View Name: Calendar Based Sorting
4|~ View Filter

T Year Actual 5ales Units Actual Sales Amount
2012 December 3,740,752 $227.090,225
November 6,527,943 $421,277,394

October 6,152,750 $364,522,428

September 7,738,345 $435,840,359

August 7,071,967 $384,254 470

Juby 6,008,177 $334,308,311

June 5287949 §205 804,171

May 4,991,233 $277,181,642

Apri 4,744 533 §262,246,245

March 5,242,572 $288,303,599

February 4 660 289 §257.863,913

January 5,007,078 $280,571,491

2012 Total 67,575,132 $3,840,207,548

2013 December 3,624,759 $220,048 674
Movember 6,093 229 5367487985

October 6,581,900 $384.333,571

September 11,125,518 $627,060,751
\%_/ 13,414 447 $755,754,978

Tubr 17833 650 $9497 £10 460
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A descending sort on Year changes the order of years to the most current of 2014 to the oldest year, which is 2012.
The current month for 2014 is September, and that is why the months of December, November, and October do not
have any data yet.

Note: For period based views that use time hierarchies, it is recommended that you set the Relationship Filter and
Empty Filter properties to No for the axis where the time hierarchies are used. In this example, both properties were
set to No for rows. This will ensure that all periods will display in the view, even those for which no data exists. For
example, if both properties had been set to Yes for the rows in this view, then the rows for December through
October of 2010 would not have displayed.

EIZ+ View Name: Calendar Based Sorfing
4|~ wiew Filter
¥ T Year| ¥ Months Actual 5ales Units Actual Sales Amount
December
HNovember
| October
| September 12,093,515 £569,861,272
| August 12,744274 485,764 510
Juby 9 613 083 $301,577 666
June 8,510,184 375,671,285
May 7,798 802 $3352,020,685
April 5,867,712 327,807,506
March 6,553 215 5361,004,874
| February 5,825,361 322,332,381
\January 6,258 847 $350,714,364
2014 Total 76,665,003 §3,537,154,864
December 3,624 759 5220048674
Hovember 6,063 2209 53567 487583
October 6,581,900 $394,333,571
September 11,125,528 627,060,751
August 13,414 447 §755,754.978
Tuhe 17,933 400 £007 A10 450
Based Time
Example 1

The next view has the Year Based Weeks Based hierarchy on rows. The first level, Year Based, is displayed and it
is sorted in ascending order. The oldest year of 3 Years Ago shows first.

E"' View Name: Calendar Based Sorting
4|~ View Filter

Year Based Weeks Based-Year Based-Abs Year Actual Sales Units Actual Sales Amount

A T Year Based

3 Years 011
2 Years Ago 012 67,575,132 $3,840,207,548

Last Year 013 123 808211 $6,968,150,351
Current Year 014 773858955 53,581,164 550
flext Year 2015

Gadtotall | o] suswsmaw
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Example 2

This view has the Rolling Year Based Months Based hierarchy on rows. Both the Year Based and Months Based

levels are displayed. There is already a descending sort on the first level.

4|~ View Filter

¥ T Year

EXZ+ View Mame: Cafendar Based Sorting

T Months Based Rolling Year Basﬂ_lrhl;n:‘l:.ﬁ?:ed- Months Based Amil Ell_llié';ales Actﬁi I:&ﬂa}!es
Current Year & Manths Ago 2014/March 6,353,215 $361,004,874
5 Months Ago 2014/ April 6,867,712 $327,807,806
4 Months Ago 2014/ May 7,798,802 $352,020,683
3 Months Ago 2014/June 8,910,194 $375,671,283
2 Months Ago 2014/ Juby 5,613,083 $351,977,666
Previous Month 2014/August 12,744,274 $485,764 510
Current Month 2014/5eptember 12,083,513 $569,861,272
Current Year Total 64,580,794  51.864,108,109
Last Year 6 Months Ago 2013/March 11,862,015 $6352,242,257
_/ 5 Months Ago 2013/ April 11,733,747 $645,861,506
4 Months Ago 2013/May 8,413,481 $468,534,747
3 Months Ago 2013/June 12,242,975 $682,957,762
2 Months Ago 2013/ Juby 17,933,650 $857,610,460
Previous Month 2013/ August 13,414 447 §755,754,578
Current Month 2013/5eptember 11,125,528 $627,060,751
Next Month 2013/0ctober 6,581,900 $354,333,571
2 Months Qut 2013/November 6,093,229 $367,487,983
3 Months Qut 2013/December 3,624,759 $220,048,674
4 Months Qut 2014/January 6,258,847 $330,714,364
5 Months Qut 2014/February 5,825,361 $322,332,391
Last Year Total 115,109,984  56,485.339,445
| GrandTotall [ 0000000000000 | 1me%07m| $9349.44755
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A descending sort is applied to the attribute relationship for the Months Based level. This arranges the Months

members within each year from the most current to the oldest month.

4|~ View Filter

Months Based [T Rolling Year Based Months Based-Mont
- Based-Abs Months

EXZ+ View Mame: Cafendar Based Sorting

~

hs

¥ T Year
Based

Current Year Current Month 2014/September
Previous Month 2014/ August
2 Months Ago 2014/ Juby
3 Months Ago 2014/June
4 Months Ago 2014/May
5 Months Ago 2014/April
6 Months Ago 2014/March
Current Year Total

Last Year 5 Months Out 2014/February
4 Months Out 2014/ January
3 Months Out 2013/December
2 Months Out 2013/November
Next Month 2013/0ctober
Current Maonth 2013/September
Previous Month 2013/August
2 Months Ago 2013/ uby
3 Months Ago 2013/June
4 Months Ago 2013/May
5 Maonths Ago 2013/8pril
& Months Ago Q}_LS,F March

Last Year Total

Actual Sales
Uinits
12,083,515
12,744274
5,613,083
8,910,194
7,798,802
6,867,712
6,553,215
64,580,794
5,825,361
6,258,847
3,624,755
6,093,229
§,581,900
11,125,528
13,414 447
17,933 690
12,242,975
8413 481
11,733,747
11,862,018

115,109,984

Actual Sales
Amount

$569,861,272
$485,764.510
$391,577.666
$375,671,265
$352,020,683
$327,807.806
$361,004,874
§2,864,108,109
$322.332,391
$350,714 364
$220,048 674
$367 487985
§354,333,571
$627,060,751
§755,754,978
$997 610 460
$682,557,762
$468 934 747
$645,861,506
$652,242 257
$6,485,330,445

| _Gandvoal] | 00000000 | e m| ssasaarss
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Guidelines for Sorting and Filtering on Totals
Here is some helpful information to know when sorting or filtering totals.
e Casual users can edit existing sorts and filters on totals.

e Advanced users and administrators can add new sorts and filters on totals and edit existing sorts and
filters.

e This feature is available on the Grand Totals that are on the same axis as the measure items. For example,
the measures items in this view are in columns. The Grand Totals in columns can have sorts and filters
applied to them.

[:_I E}: é E}_l_ .Q‘ Y @ m |I| @ 6°°e1to-|nnf2055|moomnmlﬁnfm [Viewer V]
EiZ+ View Name: Returns by Lot Reason Code
ﬂj View Filter
Rel:ui Il::.r-nn 624 625 Grand Total
mm Damaged Product Price
Lot O ctunm et Months Rekurm At Months Returm At Monkhs e
19990101914001 (5473) (S448) (3285)
19990101914002 ($439) (8433) (52E0)
19990101914003 ($629) (8593) ($383)
19990101914008 ($2,825) (52,665) 41,7119
19990101914304 (31,5213 ($1,812) (31,1699
19990101914422 ($2,282) ($2,153) ($963)
19990101914602 ($1,024) (8966) ($1,068)
19990101914603 ($630) (8651) (536T)
19990101914604 ($238) (5224) ($101)
19990101924003 ($3,279) (54,980) (32,6400
19990101924015 ($1,046) (8987) ($637)
| 19000101974401 56 1541 (53 R06) 54 /53

Copyright 2024 Silvon Software, Inc. A/l rights reserved. (Last Revised: November 2023) 27



Treat Attribute Relationship Data As Numbers In Views

Data for attribute relationships is typically treated as text (alphanumeric characters) in Stratum views, unless they
are specifically designated to be treated as numbers. That can be done at the application level by administrators,

as described in the Dimension maintenance section of help, or by any user in their individual views. See the steps
below for changing settings within an individual view.

1. In the view where the attribute relationship exists, right-click and choose Properties from the menu that
displays.

2. In the Data Type drop-down selection list of the Properties window, select Number.

3. Click OK in the Apply Changes window and save the view.

Here’s a few other things to consider about this property. The type of information communicated by an attribute
relationship and how you want it displayed in views and treated by sorts and filters helps you decide when to treat
attribute relationships as numbers instead of text.

o If the attribute relationship conveys numerical data and its values consist of all numeric characters,
consider setting their Data Type property to Number. Commodity codes or pricing data are examples of
numerical data.

e If you want an attribute relationship’s values to be treated as numeric for sorts and filters and displayed
right aligned in a view’s columns (like measure item values) and for exports to Excel that are set to be
Excel Report output types, then set their Data Type property to Number.

Can Multiple Objects be Sorted in Views?

In some cases, multiple objects can be sorted. More than one level can be sorted in the same view, but only one
measure item at a time can be sorted in a view.

See also: Why were Sorts Removed from Measure ltems?.

In this example, there is a sort on the level in columns and a sort on an attribute relationship for the level on rows.

EIZ+ View Name: Daily Sales by RepBroker and Country
4| view Filter

¥ Customer Ship-To UsA
Country =>
Daily Sales Daily Sales Daily Sales Daily Daily Sales Daily Sales Daily Sales Daily Daily Sales Daily Sales D
R k / ) _\ Amount Sales Units Amount Sales Units Amount
RepBroker [ &4 RepBr Long Description) w38 2014 to Wk 38 Wk382014toWk Wk372014toWk37 Wk372014toWk Wk362014toWk36 Wk
2014 38 2014 2014 37 2014 2014
308 Dean Cizek 9 $2,937 438 $187.361 1,118 $35,950
313 Eleanaor Toman $10,765 1,802 $686.799 4,606 $131,779
307 Guy Nelson §1,124 158 §71,684 505 $13.754
305 Janice Tierney 59,835 1422 §627.490 3,635 £120.39%
306 John Trainor
304
202

John Trasky $3,592 659 §229.153 1,685 843,969
$6.201 1.072 §395.636 2.738 $75.913

28 Working with Sorts



In this example, there is a sort on the Sales Units measure item.

42| ViewFilter T Product Group

T Year Based ==
Year Based Months Based-Year Based-Abs Year

Months

1

ber
December

g

EEE
ol

*EEIEEE

item.

E"' View Name: Monthly safes Views filftered by Product Group

Last Year

2013

Sales
Amount

$134,726,370
$120,630,704

§75,668,211
$191,238 484
$166,186,115
$170.438,747
$180,174,622
$152,231,793
$204,244 740
$281,383,297
$242,788,266
51 59,545,211

Sales Units
2,325,511
2,057,686
1,281,288
3486263
3,055,288
3,141,045
3,358,940
2,821,829
3,787,346
5,152,400
4,446 061
3,484,795

Current Year

2014

Sales
Amount

$93,102,611
$97,153,548
599415393
$103,686,072
$110.814,559
$117,183,682
$120,192.437
$137.459,746
1130,593 183

Units

1,695,884
1,782,815
1,828,038
2,232,003
2,541,088
2,888,562
3,022,329
3.672.251

3,963.6

Applying a sort to the Sales Amount measure item removes the sort that had been on the Sales Units measure

/2| View Filter T product Group

T Year Based ==
Year Based Months Based-Year Based-Abs Year

Months

EE;

:

EEE

il

E

ber
December

EXZ+ View Name: Monthly Sales Views filtered by Prodoct Group

Last Year
2013

Sales
Amount

§188,546,211
§242 788 266
$281,383,287
£204,244 740
§152,231,793
$1R0,174.622
$170,458,747
$166.186.113
§191,238,484
$134,726 370
$120,630,704

$75.665 211

Sales Units

3,484,793
4,446 061
5,152,400
3,787,345
2,821,829
3,359,940
3,141,043
3,055,288
3,486,263
2,325,511
2,057,635
1,281,288

Current Year

2014

Amount
$180,553,183
$137 459,746
§120,192,437
$117,183 692
§110,814,55%
$103 686,072

§95.415,393
$07,153,548
§93,102,611

[ ¥ Sales '\ shles Units

3,963,651
3,672,251
3,022,329
2,888,562
2,541,088
2232003
1,828,058
1,782,815
1,695,884

Grand Totalls2,109278 560|38359 452[ 1 059 601 202 3.e27.701

[ & Sales Uni
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Do Sorts Impact Measure Items with Conditional Formatting including Images and

Indicators?

Yes. When a measure item with an associated image or indicator is sorted, the value of the measure item is used in

the sort. The image and indicator are ignored by the sort.

Why can’t | Filter or Sort Cumulative Calculated Measure Iltems?

The results of a cumulative calculation are accumulating in nature; therefore, sorting and filtering functionality is not
available on calculated measure items that use cumulative functions in their expression. Those functions include
the Cumulative Total, Cumulative Percent of Total, ABC Cumulative, and ABC Cumulative Percent of Total

functions.

e Sort and Filter options will not display on the pop-up menu of a calculated measure item that uses a

cumulative function.

Sort and Filter properties will be disabled in the Properties window for those measure items.
Filtering those types of measure items will not be permitted when using the Data tab of the Filters window.
e If a non-cumulative calculated measure item has been sorted or filtered and you want to change it to a

cumulative calculated measure item, you must first remove the sorting or filtering.

The view that follows shows an example of this scenario. The “Percent of Total” calculated measure item can be
sorted and filtered because it does not perform a cumulative calculation. The “Cumulative % of Total” calculated

measure item cannot be sorted and filtered.

EXZ+ View Hame: RepBroker Cumulative Sales
1|~ View Filter
Y RepBroker Product Category A Actual Sales | percent of Total Cumulative % of Total
Jan 2014 to Sep 201
Mary Lopezr Frozen Fruit Products $3,029.23 S5 a9
Pork §7.651 .4 137 22T%
Beef $11,814 66 211% 438%
Frozen Prepared Dinners §15,690.97 2.81% T.1%%
Fresh Fruit $19.235 67 344% 10.63%
Canned Fruit §25,7353 4.60% 15.23%
Fresh Vegetables $27,251,06 4. 87% 20.11%
Mary Lopez Total £11

Eleanor Toman  Frozen Fruit Products 1.69% 21.80%
Pork $17.749.07 3.17% 24 97%
Beef 518,908,03 338% 28.36%
Fresh Fruit §32,031.42 5.73% 34.05%
Frozen Prepared Dinners 281, 1592% 42.01%
Fresh Vegetables $47.904.72 2.5 50.58%
Canned Fruit 100.00%

Eleanor Toman Total

Grand Total
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Here's the pop-up menu for Percent of Total, with the Sort and Filter options:

Copy
Select All Occurrences

Select all

Add »
Edit
Delete

Hide

Sort ¥
Filter

Conditional Format »

Actions
Transpose

View Explorer
Properties

Here's the pop-up menu for Cumulative Percent of Total, without Sort and Filter options:

Copy
Select All Occurrences

Select All

Add »
Edit
Delete

Hide

Conditional Format »
Actions »
Transpose

View Explaorer

Properties

The “Percent of Total” calculated measure item in the next view has a Recursive Top Count filter applied to it. If you
attempted to change the expression for “Percent of Total” to a cumulative percent of total, a message would display
stating that you need to remove the filter before the cumulative function can be applied to the expression.

EIZ+ View Name: RepBroker Cumulative Sales
4|+ View Filter
Recursive Top Count 5
T RepBroker Product Category A Actual Sales Percent of Total Cumulative %% of Total
Jan 2014 to Sep 2014
Mary Lopez Fresh ¥ bles 827,251,065 % 4.87% £.37%
Mary Lopez Total $27.251,065
Eleanor Toman  Fresh Fruit £32,031,428 573% 13 86%
Frozen Prepared Dinners £44 281,151 7.92% 2421%
Fresh Vegetables 847.904,721 3.5T% 3541%
Canned Fruit $276,298,202 45 42% 100 0%
Eleanor Toman Total 400,515,511
[ sewweesn] [

Copyright 2024 Silvon Software, Inc. A/l rights reserved. (Last Revised: November 2023) 31



Why is a Sort Property Disabled?
This can happen when:

e You're a casual user.

e You're working with a cumulative calculated measure item.

e You're working with measure items and there are levels on the same axis as level items.

e You are trying to sort Grand Totals that are on the axis opposite from the measure item axis. See
Guidelines for Sorting and Filtering on Totals.

Casual User

The grid pop-up menu for casual users does not have a Sort option on it. Casual users are only able to edit existing
sorts by clicking the sort icon (& or ¥) next to the sorted level, attribute relationship, or measure item.

Cumulative Calculated Measure Item

Sorting is not permitted on calculated measure items that use cumulative functions in their expression. Those
functions are the Cumulative Total, Cumulative Percent of Total, ABC Cumulative, and ABC Cumulative Percent of
Total functions. The Sort option will not display on the grid pop-up menu of a calculated measure item that uses a
cumulative function. Also, the Sort property will always be disabled in the Properties window for those measure
items.

e o Gt Corent Weck eles U
4|~ View Filter
4 | Cumulative Current Week Sales Units
Current Wk(ggm Current Wk Sales . | Parameter Groups
Amaoult Units Cumulative 4 -y
Product Family .
(Wk38 19 tg Wk38  (Wk3814towkas current WkSales
14) o Units | Rows
py
Frozen Entrée 3§, Select &l Occurrences 634435 i Columns
Frozen Individual Dinner 5§, SelectAl 131,606 . View Fitter
= — bles 5 276.070 F] . Measure Items
Tender Vegetables : T6.07
L Insert k Current Wk Sales Amount (Wk 38 14 to Wk 38 14)
el e een $p Edit 388.467 Current Wk Sales Units (W 38 14 to Wk 38 14)
Enit Flings §p,  Remave 573,263 F@ Cumulative Current Wk Sales Units
Applesauce s, o 716,529 | Presentation
Frozen Juice 55, 762,111 ; Charts
Spedalhy Canned Fruit 1, Conditional Format > 879,925
Fruit Cocktail 56, T‘"‘ft'“”s > IS PLE| Il Properties - Cumulative Current Wk Sales Units b4
ranspose ) T T T T (|
Peaches 515, 1,295,223
Valua Yas ™y
Pears 55, View Explorer 1,409 209
Pineapple sJL\_ Properties 1557639 TTE9= No
Fresh Park §5,188.822 77,286 T&315:5 |Conditional Format [No V|| |-
Eresh Beef $4.608.416 76,236 1711161 | Pop-up Expression |[No V| |
Tender Fruits $3,994,606 93,073 1,804,234 | Hyperlink [ne ~[ ...
$5,090,158 130,728 1,934,962 | Visible Yas
_ Filter v
(Sort lona ;
Total Nona
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Levels on Same Axis as Measure Items

If there are levels on the same axis as the measure items, then Sort will be disabled in measure item Properties
windows. You must first sort the measure item via the grid in relation to a particular level member on the measure
item axis.

In this view, the measure items are on the columns axis and there is an ABC Classification Code level on columns.
The Sort property is disabled in all measure item Properties windows. You can sort by right-clicking an instance of a
measure item in the grid (for A, B, or C code) and using the Sort option on the pop-up menu.

After setting up the initial sort that way, the Sort property will be enabled in the Properties window. You can then
edit or remove the sort from the grid or Properties window.

llol?ofl?l 1to 10 of 12 Viewer w
e+ View Name: Cumultive urreat Week Sales s
ﬂj View Filter
4 | Cumulative Current Week Sales Units
ABC Classification A B . Parameter Groups
Code ==
4 . Grid
ABC Long
Description A B . Rows
Current Current . Columns
Current Wk Currgnt Wk Cu | View Filter
Wk Sales  Sales Cumulative Wk Sgles Sales Cumulative Wk
Amount  Units  Current  Amognt  Units  Current  Am 4 [, Measure ltems
(Wk38 14 (Wk38 WkSales (Wk3814 (Wk38 Wk3Sales (Wk Current Wk Sales Amount (Wk 38 14 to Wk 38 14)
toWk38 14to Units toWH3E 14to Units tol
Copy 18 14 Wk 38 1 Current Wk Sales Units (Wk 38 14 to Wk 38 14)
Select All Occurrences 14) B cumulative Current Wk Sales Units
Select All 4 65,445 . Presentation
Insert R §6,08],122 66,161 66,161 | Charts
Edit 96 164,341 53
B 45 197486 §135]435 33612 99785 §24
18 319304 S§1.108.667 18,794 S-SRI Properties - Current Wk Sales Units (Wk 38 14 to Wk 38 1: X
Hid 5
oe 66 462,570 Mam= Data2
531 . i . -
_ Ascending Caption Expression Current Wk Sales Units ([From Period Shor!lzl
Descendingly POp773 35,165 173743 i
| o _ Type Regular
Clear 74214 171533 345276
ﬂcﬁhond Format '7511 331 208076 553352 Measure Actual Sales Sales Units El
. ons B bod 6z 113985 667,330 Format String As Is
ranspose ;
15 567694 $5874239 124515 791853 value es
View Explorer §1,743,899 23266 817,119 83! Image Mo
Properties
P 03 381,797 J $2¢| | Conditional Format |Nu b || [
Tender 3 4,730 67,340 B84,639 5L Pop-up Expression |Nu V“ |
§2.519.205 65178 949337 %2 - | I |
Hyperlin Mo W
i v susasmfemer]  fsssossnssomsn]  Jsnd
Visible fes
Filtar hd
t Sort Mone

Why were Sorts Removed from Measure ltems?

Sorts will be removed from measure items in these cases:
e Case 1 - You sort one measure item then apply a sort to a different measure item.

e Case 2 - The sort on the measure item was associated with a particular level, and you remove that level
from the view.

e Case 3 - You sort a measure item then sort a level on the opposite axis.

See also Can Multiple Objects be Sorted in Views?
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Case 1

In this view, there is a sort on the Sales Units measure item.

/= View Filter ¥ product Group

T Year Based ==
Year Based Months Based-Year Based-Abs Year

Months

1

ber

5
g
4

-

EEE‘
ol

E"“ELEIEEE

E"' View Name: Monthly sales Views fiftered by Product Group

Last Year

2013

Sales
Amount

§134,726370
$120 630,704

§75.665 211
$191,238 4834
5166,186.115
$170.458,747
§180,174.622
$152,231,793
§204,244.740
$281,383,297
$242 788 266
£1 39,5-145,211

Sales Units
2,325,511
2,057,686
1,281,288
3486263
3,055,288
3,141,045
3,358,940
2,821,829
3,787,346
5,152,400
4,446 061
3,484,795

Current Year

2014

Sales
Amount

$93,102,611
$87,153,548
599415393
$103,686,072
$110.814,559
$117,183,682
$120,192.437
$137.459,746

[ & sales Uni

Units

1,695,884
1,782,815
1,828,038
2,232,003
2,541,088
2,888,562
3,022,329
3.672.251

1130,593 183

Applying a sort to the Sales Amount measure item removes the sort that had been on the other measure item.

3,963.6

4|2/ View Filter ¥ product Group|

T Year Based ==
Year Based Months Based-Year Based-Abs Year

Months

EE*

:

EEE

il

E

her
December

EIZ+ View Name: Monthly Sales Views fiftered by Product Group

Last Year
2013

Sales
Amount

§188 546211
§242 788 266
§281,383.287
£204,244 740
§152,231,793
$1R0,174.622
$170,458,747
$166.186.113
§191,238,484
£134,726 370
$120,630,704

§75.665211

Sales Units

3,484,793
4,446 061
5,152,400
3,787,345
2,821,829
3,359,940
3,141,043
3,055,288
3,486,263
2,325,511
2,057,686
1,281,288

Current Year

2014

{ W Sales

Amount
$180,553 183
§137 459,746
$120,152 437
$117,183 692
§110,814,55%
$103 686,072

§95.415,393
$07,153,548
§93,102,611

Grand Totalls2,109278 560|38359 452[ 1 059 601 202 3.e27.701

Sales Units

3,963,651
3,672,251
3022329
2,888,562
2,541,088
2232003
1,828,058
1,782,815
1,695,884
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Case 2

There is a sort on the Daily Sales Amount measure item for member C of the Product ABC Class level.

EXZ+ View Name: Daily Sales by Product ABC Class
4| View Filter

Product ABC
Class ==

Product PBrnd Long

Dby Daiby

Daily Sales Sales Daily Sales Sales
Amount Units Amount Units
Wk382014 Wk38 Wk382014 Wk38

Leid Description 4wk 38 2014to  toWk38 2014to
2014  Wk38 2014  Wk38
2014 2014
o011 First Choice $7.131 1640  $9397 1,713
009 Farm Fresh $10432 1469  $14281 2,671
010 Prime Grown 56,636 1,224
0oz Dew Drop $1.166 438
007 SugarDrop
001 Tip Top §3,903 531
003 SuperSweet 1,436 352
004 1daho Delight $1,573 414
005 Farm Crisp 52,835 77
006 Southern Sweet $3,544 531
008 Bing-a-ling
012 Home Cookin’ $7,132 794 $6947 809
999 Private Label

C

¥ Daity

Sales
Amount
Wk 38 2014
to Wk 38
2014

$5,808
$5,384
54,334

§2,955
§2,071

303

The Product ABC Class level is removed from the view; therefore, the sort is removed.

EIZ+ View Name: Daily Salfes by Product ABC Class
4|~ View Filter

e sl 1] ﬁfﬁ e 330::-13?? i
011 First Choice §22,353 4 666
009 Farm Fresh £38.290 6,697
010 Prime Grown $10,990 1,817
o002 Dew Drop £4.121 867
o007 SugarDrop 52,071 305
001 Tip Top §3,903 531
003 SuperSweet $1.436 352
004 Idaho Delight $1,573 414
005 Farm Crisp 52,833 778
006 Southern Sweet 86,579 1365
008 Bing-a-iing $4,022 574
012 Home Cookin® $14.080 1,603
999 Private Label $4,935 1,124
Commitom] |l e

$3,034
§4.022

Daity
Sales

Units
Wik 38
2014 to
Wk 38
2014

1,563

834
574
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Case 3

In this view, measure items are on the rows axis. There is a sort on one of the measure items.

Budget
Amount

Grand Total - $5,078,516,759|  §2,219.250,196
Wo!

| | |salesamount| s4977.057.97| $2.88247.89

EiZ - View Name: Sales and Budget by Region, RepBroker
4|~ View Filter
RepBroker > > 300 305 313 312 302
Region Di?;‘ri)ﬁmg Dﬁclrriltimg Nicole Toscano Janice Tierney Eleanor Toman IMike Hartney Mark Fedler John
330 East B“dﬁ: r"‘j‘_"“;"t $5.078,516,75%  $2,219250,196  $1852719.651  §1.423069.721 $600,722,027 53
b Sﬂ? $4.977.057972  §2,188,247.896  $1,813251,060  §1,392,813,357 $588,990,820 )
Cumulative Sales $4.977.057.972 48 $7.165.305,868.54 $8.978,556,028 88 $10,371,370,786.37 $10,960,361 60650 $11.315)
Sales 9% Total 41.00% 18.03% 14.54% 11.47% 4.85%
Budget Amount
331 West Working $314.604.275 s:I
Sales Amount §312,314,732 g
Cumulative Sales $312,314,732.03 §457)
Sales 3% Total 13 .88%

£1,852,719,651

$915,326,307

$1,813,251,060]  $1,392,813,857 $901,305.552

Then a sort is applied to the level on columns, which removes the measure item sort.

iI= View Name: $Sales and Budget by Region, RepBroker
4|~ View Filter

318

¥
RepBroker == 31
Rgn long | RepBrLong

D inti = Meidl MacDonald Mary Lopez

313 312 309

Eleanor Toman Mike Hartney Terry Bruno

Budget Amount
Working

Sales Amount
Cumulative Sales
Sales % Total

Budget Amount
Working

Sales Amount 5175890506  $474,781,394
Cumulative Sales $173,899,506.29 $650,681 40034
Sales % Total T.81% 21.09%

East

West 5176582304  $479,040,355

$321,722.9%6

$1,813,251,060  $1,392,813,857 $316,327,928
$1,813,251,060.34 53 206,064,917.83 $3,522.392,846.22
14.94% 11.47% 2.61%

51,852,719.651  $1.423.069.721

§30¢

838
§1,040.3

Budget
Grand 'I'ntal Amount $176.582,394| $479.040,355| $1,852,719.651| 51,423,065, $321,722,996
Working

| | [salesamount| sizssm9s06] saramsiess] sisisasioco] siamsasst]  saieaes|

Sales % Total
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